
Weekly Laugh:
Signs with
Unintended
Messages

Outside a country shop in
West Virginia: “We buy
junk and sell antiques.”

In the window of an
Oregon general store:
"Why go elsewhere to be
cheated, when you can
come here?”

In a Kansas City oculist's
office: “Broken lenses
duplicated here”

On a Jacksonville, Florida
bookstore: “Rare, out-of-
print, and nonexistent
books"

 

 

  Week 3: Information Literacy &
Writing Across the Curriculum

With the rising use of the Internet in student papers
and research projects, students need to be taught
how to think critically about their sources. In addition,
an information literacy process in your classroom will
assist students in applying higher order thinking skills
to your content area.

Objectives

 Participants will design developmentally
appropriate learning opportunities that apply
technology-enhanced instructional strategies
such as project based learning, information
literacy skills, problem based learning, and
cooperative learning to support the diverse
needs of learners.

 Participants will identify and locate
technology resources and evaluate them for accuracy and
suitability.

 Participants will apply technology to develop students' higher
order skills and creativity.

Suggested Schedule

 Sunday - Monday Examine (approx. 60 min.)
 Tuesday-Friday Discuss (login in daily for half an hour, 2

hours total)
 Tuesday Explore (approx. 45 min.)
 Wednesday-Thursday Implement (approx. 1-2 hours)
 Thursday Manage (approx. 15 min.)
 Friday Ethics (approx. 30 min.)
 Weekend Catch up on work if necessary.

© 2001-2004 AVLN. Course prepared by Marilyn Eggers & Janine Lim. Updated April 2004.
 

Intro file:///Volumes/data/Janine/J/onlineclasses/ITC%206%20weeks/w4...

1 of 1 3/14/09 10:34 PM



 

 

  Week 3: Information Literacy & Writing Across the
Curriculum

Read at least two articles listed below.
We encourage you to bookmark and/or print articles and links that you enjoy
in the class.
Graduate credit requirement: Read three of the articles each week and include information
from the three articles in your initial Discuss post.

Copyright

 Required! The Educator's Guide to Copyright and Fair Use A must read!
Print the handy chart to keep for reference.

Information Literacy

 The Web -- Teaching Zack to Think Is your school teaching students to
access the Internet for research? Then it is essential that students also learn
how to validate the information.

 Questions as Technology The most important technology of all is the
ability of students to make meaning by applying sharply honed questioning
skills.

 Off Road Thinking: Looking for Great Surprises This article explores the
important role surprise can play in the discovery and invention of new ideas -
a student capacity now being emphasized by most state curriculum
standards and a workforce capability much desired by employers.

 Research Foundations of The Big6"! Skills The Big6 is based on a rich
foundation of research into how humans find and process information
(information literacy), and this research basis has led to the development of
similar and complementary approaches that create a more complete picture
of ways people solve information problems.

 Two foundational articles:

Information Literary
Information Literacy and Lifelong Learning 

 Plagiarism It is when students are young that we need to begin educating
them about responsible use of any product as that is the time the problem of
plagiarism begins.

 The New Plagiarism Sometimes you need to change your
requirements and assessment practices to combat plagiarism.
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Writing

 6+1 Trait TM Writing Research How does writing impact
achievement? Read at least one of the studies listed here.

 Introduction to Blogs and Blogging This term from cyberspace
carries an air of mystery sprinkled with a dash of high tech. Blog is a
shorthand term for a Web log or Internet journal. A blog is high tech
and futuristic and may get students interested in writing. See also All
the World's a Stage.
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  Week 3: Information Literacy & Writing Across the
Curriculum

In the discussion area,

After reviewing the articles under Examine, go to the Discussion Board and
locate the Week 3: Discuss response forum. Then answer two of these
questions in one message.

 How did you teach information literacy before the Internet?
How do/can you teach it now? What has changed? How
can/should this impact your classroom?

 How can teaching information literacy skills reduce plagiarism
in your classroom?

 Why should we teach information literacy skills? Share an
experience to illustrate your point.

Remember to reference the two articles you read in your message (3 if
you're taking the class for graduate credit. Please respond to the articles
(not a summary) with a heading for each, and then answer each question
with a heading. Put this initial response in one message.

Respond to at least one other person's message. We're looking for a
quality conversation here - more than a simple 'I agree'. These may give you
a place to start:

 Did the post-er present an idea that is new to you?
 That you were surprised at?
 Do you see the same thing (or something completely different)

happening in your classroom?
 Were you confused by their idea(s)?
 Was there anything you disagree with? Share your

perspective.

Scoring Checklist

Response to the readings &
introduction

15
pts.

Response to someone's posting 10
pts.

Total possible points for this week's
Discuss

25
pts.
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  Week 3: Information Literacy & Writing Across the
Curriculum

Remember to bookmark and/or print articles and links that you enjoy in this
class.

Sample Lessons & Links | Evaluation | Research Tools | Research Planning
Content Writing | Write about Reading | Writing Instruction

Sample Lessons & Links

 How Stuff Works Bookmark this site for the next time a student asks one
of those 'why does it' questions!

 For high school students, use a cooperative learning strategy called
Reiterative Problem Based Learning. Use the Internet as one of the
resources for investigation.

 Adaptable for all grade levels Create an Alphabet Book.

 Grade K-2 Here a Bug, There a Bug.

 Grades 4-6 Predicting the Weather.

 Grades 5-8 Be a TentMaker (models the integration of faith and learning).

 Grade 7 Economic Botany: Plants - Where in the World?.

 Grades 9-12 Social Studies: The Gilded Age.

 Lots of WebQuests for all grade levels. Check out the Top link to find the
best ones.

Evaluation of Information

 ABCDs of Evaluating Internet Resources Web pages should be evaluated
carefully using some of the same criteria one uses to evaluate a print source.
Be aware, however, that Web pages present additional evaluation
challenges.

 Aluminum Foil Deflector Beanie Are you a victim of mind control? Try this
Deflector Beanie technology.

 Better Read That Again: Web Hoaxes and Misinformation James, an
eighth grader at Bellair Middle School, was working at home on a paper due
the next day. The paper was for the Martin Luther King Day Essay Contest.
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His teacher had emphasized coming up with something original.

 California's Velcro Crop How is velcro made?

 Dihydrogen Monoxide Research Division Hmm. Is this true? Do you know
what Dihydrogen Monoxide is? Ask your chemistry teacher!

 Grammar of the Internet Who published the site? Who links to it? What
does this tell us about its validity?

 Mankato, MN. Want to visit? Scroll to the very bottom and read the
disclaimer.

 Media Literacy Thinking critically about the world around us.

 U.S. DOE Computer Incident Advisory Capability (CIAC) Hoaxbusters

 WEB LITERACY and Critical Thinking: Is it a Hoax? A collection of links to
sites that are hoaxes. How can you use these to teach students to verify
Internet information?

Research Tools

 Citing Internet Resources How to cite websites, email, and more.

 EasyBib An online citation tool.

 Noodle Tools is a suite of interactive tools designed to aid students and
professionals with their online research. From selecting a search engine and
finding some relevant sources, to citing those sources in MLA or APA style,
NoodleTools makes online research easier!

 Scholastic Research Starters Includes definitions, an introduction, links,
articles, and recommended research topics.

 The New Plagiarism: Seven Antidotes to Prevent Highway Robbery in an
Electronic Age Note especially antidote #6.

 Web Literacy and Critical Thinking: A Teacher's Tool Kit This practical
guide offers classroom activities and exercises that train your students to be
discerning consumers of information on the Internet.

Research Planning
If students are research separate topics, you will need to carefully plan and
create a definite structure for their research. Don't let students loose on the
Internet to wander at will. They will drift to their favorite sports pages, or
worse, to inappropriate sites. There are ways to structure the assignment that
can lessen this possibility.

Explore file:///Volumes/data/Janine/J/onlineclasses/ITC%206%20weeks/w4...

2 of 7 3/14/09 10:35 PM



 Think carefully about the topic assigned or chosen for the research paper
or project. Consider fact finding vs. critical thinking/synthesis. Topics that
require higher levels of thinking will reduce plagiarism. Consider these
objective verbs for your assignments: compare, contrast, categorize, criticize,
diagram, organize, predict, improve, propose, formulate, select, decide,
recommend, rate, validate, and justify.

 Have students question. Rather than gathering all information regarding
the subject, form key questions so that only pertinent information is retained.
Questions should focus on big issues; begin with why...? and how...? and
should...?

 Consider creating Essential Questions.

 The Question is the Answer. What questions do you encourage your
students to ask?

 Before searching, generate keywords. Use Inspiration or other tool to
identify keywords related to your topic. Have students come up with 20-30
keywords before touching a computer.

 Require other sources. Have students list books, magazines, journals,
and other sources they can use before going to the library. Assign a certain
number of sources from the Internet, and a certain number from print
materials.

 Use a research planner to guide students planning. Require it just as you
require notecards for papers. Require the sheet be completed before
students go to the lab or library.

Content Writing Ideas

 Adapt a cooperative learning strategy to use technology:

Roundtable. Technology Example: Have students write on an
AlphaSmart or similar device and then pass on to the next person
in the group/class. View a lesson plan using this idea.

KQLA or Modified KQLA. Technology Example: Students work in
small groups (3 or 4) and complete the worksheet/information in a
word processor or Inspiration, the brainstorming tool.

 Resources for Writing in the Sciences

 Writing Across the Curriculum: Writing Prompts Arranged by Department

 Creating Writing Prompts Tips, narrative, expository, and persuasive
examples.
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 Writing Activities and Prompts for various content areas.

 Multigenre Web Many types of writing to integrate in your content area.

 Use graphic organizer templates to help students understand a topic or
start a report. 5 Kingdoms template and 5 Kingdoms project completed.

 Flat Stanley Paper dolls (Flat Stanleys) and blank journals are exchanged
with other classes, families, or celebrities. His adventures in the visiting city
are recorded and sent back to you with photographs & souvenirs.

 Inspiration templates Using graphic organizers in all curriculum areas
K-12.

 Types of Journals to use in all content areas.

 ePals Locate a classroom in another town, state, or country to exchange
email between your class and theirs.

Math

 A Guide to Writing in Mathematics

 Math Journal Ideas

 Why Students Should Write in Math Class plus writing prompts for K-12
math classes.

Write about your Reading

 Weekly Reader Writing, games, reading. Extensions of the Weekly
Reader magazine  but you don't have to subscribe to use this site.

 Insert digital pictures of each student into your word processor. Students
can edit their pictures using ImageBlender to make themselves into a story
character. Add written characteristics of their character.

 Once a month, have kids write book reviews about several favorite books.
Vote on the class favorites & send the top 3 stories & reviews to the class
website.

 Create a story map using Inspiration. pictures or words to sequence the
story in pre-drawn rectangles connected by arrows.

 Create a Venn Diagram and compare 2 stories or characters.
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 Create a book report template in a word processing program. When
students have finished a story, they call up the template & enter their
information  name, title, author, genre, & their feelings about the story.

 Assign students to retell the main ideas of a story using a slide show.
Limit the number of slides they may have and require pre-planning of their
slides.

 Reading response ideas:

create a 4-slide show showing the title and author, beginning,
middle, and end,
or create a 5 -slide show showing the title & author, characters,
setting, problem, and solution
or create a retelling of the story with a new ending, or a new
setting, or new characters.
or retell with the characters and word balloons (use circle tool and
lines)

 Create reading responses: using rectangles and lines, kids can&

sequence story events by creating a flow chart,
or create a grid to compare several stories
or circles to create a Venn diagram for story/character
comparisons
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or use lines to create sections for a newspaper format. Groups
can write articles about the stories they are reading.
or do a character study by drawing the character and writing
several characteristics.
or drawing and labeling/recording your favorite part of the story.
or creating a new cover for the book.

Writing Instruction

 Acrostics for Children Lots of examples here for children Grade 2+

 One student can start a story by entering text on an AlphaSmart, then
pass it to a 2nd student who continues, etc. Or do the same on computers in
the lab. Every 10 minutes, students can shift to the next computer to continue
a new story.

 Use Slideshows to publish student stories. This will take some thought on
their part as to how to divide their story into pages. Another great way to
show off at Conferences or Curriculum Nights. Print out individual pages for
their portfolios (SlideShows don't print)!

 Wacky Tales Type in parts of speech to finish a story (like Mad Libs) See
also Wacky Web Tales from Houghton Mifflin.

 Enhance the use of descriptive words. Assign students to create a picture
with a stamp or import a clip art picture. Then students write a description of
the image.

 Add "Snap" to language arts with this Kodak lesson plan! See other
Kodak lesson plans here.

 After a vacation, kids can choose a graphic, draw and write or record
what they did. Assemble as a SlideShow.

 Writing Prompts Use these whenever the creative juices stop flowing!

 If your students are writing in Word, try this little trick! Turn on the
Readability stats. From the menu, choose Tools, Options, Spelling &
Grammar, Show Readability Stats. Then run the spell check. Notice the stats
included in the report. Encourage students to aim for a certain score with
their writing.
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 Digital Storytelling. Students create a movie with their written work.
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  Week 3: Information Literacy & Writing Across the
Curriculum

The Implement tasks should take about
an hour or two of your time. Often, you
could spend longer on the task, but we
encourage you to budget your time and
focus on what is most useful for your own
learning.

Pick one of the project options. Many
include further instructions, so be sure to click on the link for that assignment.
Then post your assignment in the Discussion Board and give feedback to at
least one colleague.

The Big6™ Skills
In the Implement project this week, you will choose an option that meets one
or more of the Big6 Skills. So start by reading a quick overview of the Big6™
Skills if you are unfamiliar with them.

 1. Create a research planning worksheet for your students to use for a
unit that you teach.
Big6™ Skill #1. Task Definition: 1.2 Identify information needed in order to
complete the task (to solve the information problem).
Big6™ Skill 2. Information Seeking Strategies: 2.1 Determine the range of
possible sources (brainstorm).

 2. Find and evaluate five websites that match a unit that you teach.
Big6™ Skill 2. Information Seeking Strategies: 2.2 Evaluate the different
possible sources to determine priorities (select the best sources).

 3. Create a Filamentality Hotlist or Treasure Hunt to assist student
research.
Big6™ Skill 5. Synthesis: 5.1 Organize information from multiple sources.

 4. Add pictures from the Internet to a writing project. Create a
bibliographic entry for the images used. (Don't just assume you know what is
required for this project. Be sure to read the instructions!!)
Big6™ Skill 5. Synthesis: 5.2 Present information from multiple sources.

 5. Use Inspiration, a brainstorming tool, during the writing process. If you
don't have Inspiration, you can download a 30-day trial version to do this
project.
Big6™ Skill #1. Task Definition: 1.1 Define the information needed. 1.2
Identify information needed in order to complete the task (to solve the
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information problem).
Big6™ Skill 5. Synthesis: 5.1 Organize information from multiple sources.

 6. Already know how to do the above? Use directions from a Word
Newsletter workshop to create a newsletter, preferably a classroom
newsletter with student writing. Even if you're a Word pro, you just might
learn something new here!

Final Project
It's time to start thinking about your final project. Click Course Information,
Final Project to read about the requirements. You are encouraged to
incorporate Implement projects from the next few weeks into your final
project. Everyone, at each participation level, is expected to complete a final
project in this class. The final project is due in week eight.

Scoring Checklist for Implement

Post an Implement project 15 pts.

Response to someone's posting 10 pts.

Total points for this week's Implement
project 25 pts.
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  Week 3: Information Literacy & Writing Across the
Curriculum

Implement Option 1: Create a
research planning worksheet for your
students to use for a unit that you
teach.

Two Examples
Begin by examining these two
examples for ideas.

 Big6 Research Organizer

 Research Planner

Create a Research Planner
Now, adapt these ideas and what you've learned from Examine and Explore
this week to create a research planner or worksheet for a unit that you teach.
Create the worksheet in your wordprocessor. Remember to include a place
for students to write their name and research topic. Include credit for the
ideas in the footer of the page.

Example for Students
Then fill out your research planner for a unit that you teach or a research
project you have students complete. Create a completed example for your
students.

Save as....
Look under the File Menu for Save As... or Export. Save the file as a RTF
(Rich Text Format) so that everyone in the class can read your file.
WordPerfect Users, see if you have Publish to PDF or Save as PDF options.
Don't panic if some of the formatting is lost. This is normal when converting
files.

Post Project
Then save your project and post your file online in the discussion area using
these instructions.

Response to Other Projects

Each week you should REPLY to at least one of your classmates' projects
and give them feedback. Suggested starter words for your feedback:

I particularly liked . . .
You might want to look at these resources . . .
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Did you think about . . .
I wondered about . . .
I've been successful with similar activities when . . .
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  Week 3: Information Literacy & Writing Across the
Curriculum

Implement Option 2: Find and evaluate five websites that match a unit that
you teach.

Evaluation Criteria
Choose five criteria from the following sites for your evaluation.

 Evaluation Criteria and Biblical Principles

 The A B C Ds of Evaluating Internet Resources

 Analyze the site's web address. What does it tell
you?

 Who is the owner of the website? What are the
implications?

 Who links to the web site?

Find Five Sites
Use the Four Ways to Search the Internet to find five websites on a topic you
teach.

Write it Up!
Use your favorite word processor to write up your evaluation. List the five
criteria you chose and why. For each website, include the URL or web
address, the title of the site, and how it meets your evaluation criteria.

Save as....
Look under the File Menu for Save As... or Export. Save the file as a RTF
(Rich Text Format) so that everyone in the class can read your file.
WordPerfect Users, see if you have Publish to PDF or Save as PDF options.
Don't panic if some of the formatting is lost. This is normal when converting
files.

Post Project
Then save your project and post your file online in the discussion area using
these instructions.

Response to Other Projects

Each week you should REPLY to at least one of your classmates' projects
and give them feedback. Suggested starter words for your feedback:
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I particularly liked . . .
You might want to look at these resources . . .
Did you think about . . .
I wondered about . . .
I've been successful with similar activities when . . .
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  Week 3: Information Literacy & Writing Across the
Curriculum

Implement Option 3: Create a Filamentality Hotlist to organize information
for a student project. Include at least 10 links in your project.

Filamentality is a fill-in-the-blank tool that guides you through picking a topic,
searching the Web, gathering good Internet links, and turning them into
learning activities. It combines the "filament" of the Web with a learner's
"mentality".

 Choose the ‘Start a new topic' option from the home page to begin your
activity.

 Fill in the blanks.
 Click on Spin this Thing!

 Print the page so you remember the password.

Add Links
 Click on Add Links at the bottom of the page.

 Then use two browser windows & copy and paste to get the URLs (web
addresses). Also write titles and descriptions.

 First, open a new window to find your pages. File, New, Window.
 Then find a website. (You may use a search engine, or you may have it

already bookmarked.)
 Then copy the web address:

drag across the "location" line to highlight the URL, then...
do an Edit - Copy on the menu bar
then switch back to your Filamentality browser window (task bar or
Window on the menu)
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Then click the cursor into the URL box and do a paste ("Edit - Paste"
from the menu bar).
Repeat this for as many URLs/Web sites as you like. If you want more
than three, click on Add Links at the bottom of the screen.

Saving
 Click on Hotlist to save your work. Note that the only time your work is

saved is when you click on the menu at the bottom of them screen.

Customizing
 Now the customization page comes up. Here you can edit the title and

introductory paragraph of your project. Edit at needed. You probably don't
need to change much here - although you may want to organize your sites
into categories.

Post on the Web
 To finalize your project and post it on the web, click on Hotlist at the

bottom again!

 Now you'll be given the web address of your project. You should print this
page as well or write down the web address (or add it to your favorites!).
You'll need this address to share your project with the class.

Filamentality's Posting Policy
You have spent quite a bit of time collecting sites. It's important that you
understand the posting policy for your project. Your project can stay on the
web for 12 months, during that time if you make changes, you extend that
time another 12 months. This can be a good way to incorporate your web
project into units that you do each year.

Editing Your Project
 When you want to edit your project, visit the Filamentality page, and this

time click on Return to Existing Topic.

 Then scroll to the bottom. You can Add Links or Edit Links.

Post Project
When you are finished, post the URL to your project in the discussion area
using these instructions. Make sure your project has at least 10 links in it.

Response to Other Projects

Each week you should REPLY to at least one of your classmates' projects
and give them feedback. Suggested starter words for your feedback:
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I particularly liked . . .
You might want to look at these resources . . .
Did you think about . . .
I wondered about . . .
I've been successful with similar activities when . . .
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Fair Use Guidelines for
Images

You may use:

Up to 5 works from one

 

 

  Week 3: Information Literacy & Writing Across the
Curriculum

Implement Option 4: Add pictures from the Internet to a writing project.
Create a bibliographic entry for the images used.

Choose a picture or collection of pictures online and use it to create a one
page Word project as an example of what your students could create to
enhance a unit you teach.

Begin by choosing a picture from one of these websites.

 Pics4Learning
 Photographic Libraries: Archive Collection
 Art: Treasures of The Louvre
 Literature: American Literature Archive Gallery
 Math: Gallery of Mathematical Images
 Science: The Space Images Archive
 Social Studies: Library of Congress American Memory

Collections: Photos

Then consider what type of lesson you could create or adapt.
Pics4Learning has many lesson plans if you need an idea.

Now create a one page sample of a finished assignment you might have
your students complete for a unit that you teach. Here are some ideas:

 Descriptive Words: Add a picture from the Internet to your
page. Describe it using lots of descriptive words.

 Story Starter: Use the picture as a story starter. Write a story
and illustrate it.

 Concept Summary: Write a summary of a concept covered in
class and illustrate with a picture from the Net.

 Create a poster illustrating a concept.
 Create a photo essay about an event or topic.
 Do a photo analysis.
 Create an illustrated graphic organizer such as a KWL

Write at least one paragraph to go with at
least one picture.

Copying a picture from the Internet
Move your mouse over the picture.

On a Windows computer, click the
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author.
Up to 10% or 15 works,
whichever is less, from
a collection.

For more information in an
easy to understand format,
visit Copyright Bay.

RIGHT mouse button
On a Mac, click and hold down the
single mouse button.

A small menu will appear. Choose Copy
Image.
Switch to your Wordprocessor and click Edit,
Paste.

Word Picture Editing Tips

Handles on the edge of the picture can be used to resize the picture.

Easy Rule to
Remember: Two
arrows resize; four
arrows move.

Moving the picture is
often annoying until
you change the
wrapping style.

With your picture
selected, look for the
picture toolbar. It
might be at the top or bottom of your screen. If not, click View, Toolbars, and
make sure that Drawing is checked.

 Click on the text wrap option. I usually choose Square or Tight. Play with
the options (with lots of text on your page) to see how each one works.

Now click in the middle of the picture to drag it around. Notice how the text
adjusts around it.

That's all you really need to do this project, but if you want more, check out
these handouts:

 Creating a Card
 Creating a Poster
 Creating a Venn Diagram

Required Bibliography
Be sure to include credits or a bibliography at the end of your document
indicating the source of your picture(s).

Pics4Learning gives the bibliographic entry with the pictures. For example:

Page, Brian. kitten05.jpg. 1976. Pics4Learning. 23 Feb 2004
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<http://pics.tech4learning.com>

Photographer (or source). Filename. Date of picture if known.
Collection Name. Download Date. <URL or web address>

Save as....
Look under the File Menu for Save As... or Export. Save the file as a RTF
(Rich Text Format) so that everyone in the class can read your file.
WordPerfect Users, see if you have Publish to PDF or Save as PDF options.
Don't panic if some of the formatting is lost. This is normal when converting
files.

Post Project
Then post your file online in the discussion area using these instructions.
Make sure it has the required bibliographic entry.

Response to Other Projects

Each week you should REPLY to at least one of your classmates' projects
and give them feedback. Suggested starter words for your feedback:

I particularly liked . . .
You might want to look at these resources . . .
Did you think about . . .
I wondered about . . .
I've been successful with similar activities when . . .
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  Week 3: Information Literacy & Writing Across the
Curriculum

Implement Option 5: Use Inspiration, a brainstorming tool, during the writing
process. Enter 20-30 keywords using one of the Writing Process Ideas below
as your guiding task.

(The intent of this exercise is NOT to teach you everything that Inspiration
can do, just to give you a taste. If you want to learn more about it, view and
print this handout for a 2 hour Writing Workshop with Inspiration workshop.)

Writing
Process
Ideas

Inspiration could be used to brainstorm at the beginning of the
writing process. From the brainstorming map, students could click
Outline to switch their mind map to an outline format. From there
it could be exported to their favorite word processor to complete
the writing assignment.

 Inspiration could also be used to plan our search of the
Interent as shown in the examples. Students could create a web
of 20-30 keywords to search on the Internet. This idea comes
from Flashes of Inspiration: Webbing the Web. It gives them a
place to start when they sit down at the computer.

 Or students could use Inspiration to keep track of resources
and references found as they research on the Internet and in the
library.
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 What other ideas do you have?

 Installing Inspiration
Visit Inspiration.com and download the trial version and install it on your
computer. The trial version of Inspiration will work on your computer for 30
days. (If you teach K-3, you might want to download Kidspiration, the kids
version.)

 Starting Inspiration
When you start Inspiration, you're in Diagram view. The Main Idea symbol
appears in the center of your screen, with the place holder text, Main Idea,
already selected. All you do is type keywords.

 Rapid Fire

Use RapidFire when you want to brainstorm, capturing your
ideas quickly without worrying about their order. You add ideas right into the
selected symbol, letting Inspiration create new symbols for your ideas.
· Select your Main Idea (or any other symbol).

· Click the RapidFire button and the lightning bolt appears.
· Type a new idea and press Enter.
· Type another idea and press Enter.
· Click the RapidFire button to turn it off.

 Editing Text
To fix any errors in symbols, double click the text in the symbol, then select
the words you want to change and type over them.

 Moving the symbols
Click and drag the symbol.
Click outside of the diagram to deselect the symbol.

 Check Your Time!
If this has taken you a while to figure out, finish entering your 20-30
words and jump down to saving the file. If you are doing ok and would like to
spend more time with the software, keep reading.

 Other ways to enter information:

Create
Use the Create button to quickly build your diagram.

· Select the symbol the new symbol will be connected to.
· Position the mouse pointer over the arrow on one of the Create buttons.
Notice how the arrow is highlighted to show you the direction in which the
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new idea symbol will be created.
· Click the arrow you wish.
· The new symbol connects to the selected symbol at the angle you chose.
· Type your information and try another one.

 Adding Unconnected Symbols
Drag symbols over
· Find a symbol on the Symbol Palette that you like.
· Click on it and drag it over to your diagram.
· Type your information and try another one.

Point and Type
· Choose a symbol from the Symbol Palette.
· Click in the open area on your diagram where you want a new
symbol.
· Type your information.
· A symbol pops up to hold the information.
· Click away from the symbol to deselect it.

 Linking Unconnected Symbols
Now that we have unconnected symbols, we may want to link them to our
other ideas. We will link from the primary symbol to the secondary symbol.

Use the Link button
· On the toolbar, click the Link button.
· The cursor becomes a two-headed arrow.
· Click the primary symbol to tell Inspiration where you want to draw the link
from.
· Click the secondary symbol to indicate where you want to draw the link to.
· The link appears, connecting the primary to the secondary symbol.
· Click the Link button again to turn it off.

Draw connections manually
· Click on primary symbol.
· Click on one of the four diamonds and drag an arrow to the appropriate
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symbol.
· When the symbol highlights, release the mouse button.
Save
Click File, Save As... to save your first Inspiration file.

 Print
Click File, Print or Print Preview to print your pages.
Use Print Setup to change the page from Portrait to Landscape. Sometimes
your diagram will fit on the page better this way.
Choose Print Options to fit your diagram to a single page.

 Change symbol shapes, fonts, colors, and links
Change symbol shapes by selecting and then choosing another shape from
the palette. Use the arrows at the top of the palette to find other symbols.
Use the Format menu to change the fonts.
Use the Effect menu to change colors.
Use the Link menu (select the link first) to change the appearance of the
links.

 Save the Inspiration file.

 Export to a JPG. This will allow everyone in the class to view your
project.

Make sure you're in Diagram View.
From the menu, choose File, Export.
Click on the radio button beside JPEG. Click Save.
Save it in a place where you'll remember where you put it, and give it a
name you can remember. Write it down! You're going to need it again!
Next you will post this file in the appropriate Discussion area and give
feedback to your classmates.

Post Project
Then post your file online in the discussion area using these instructions. Be
sure to tell us a bit about how you see this project fitting your curriculum.

Response to Other Projects

Each week you should REPLY to at least one of your classmates' projects
and give them feedback. Suggested starter words for your feedback:

I particularly liked . . .
You might want to look at these resources . . .
Did you think about . . .
I wondered about . . .
I've been successful with similar activities when . . .
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  Week 3: Information Literacy & Writing Across the
Curriculum

Implement Option 6: Create a newsletter with student writing.

This project assumes you're already somewhat familiar
with Word. Begin by exploring the following handouts. The
Newsletter handouts are from a jigsaw workshop where
teachers work in teams of four. Each person learns one
piece and then the group creates a newsletter together.

 Word Callouts

 Newsletters: Masthead, WordArt, Lines, and Columns

 Newsletters: Pictures, Photos, Digital Pictures and Pictures in
Shapes

 Newsletters: Text Boxes, Drop Letters, Borders, Templates

 Newsletters in the Classroom

Create a Newsletter
Then create a newsletter. At a minimum, include a masthead, lines,
textboxes, graphics and columns.

Save as....
Look under the File Menu for Save As... or Export. Save the file as a RTF
(Rich Text Format) so that everyone in the class can read your file.
WordPerfect Users, see if you have Publish to PDF or Save as PDF options.
Don't panic if some of the formatting is lost. This is normal when converting
files.

Post Project
Then post your file online in the discussion area using these instructions.

Response to Other Projects

Each week you should REPLY to at least one of your classmates' projects
and give them feedback. Suggested starter words for your feedback:

I particularly liked . . .
You might want to look at these resources . . .
Did you think about . . .
I wondered about . . .
I've been successful with similar activities when . . .
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  Week 3: Information Literacy & Writing Across the
Curriculum

One Computer Classroom

 That's Not a Drinking Fountain or How to Survive in a One Computer
Classroom.

Cheating

 Digital Deception How will you prevent cheating in your classroom? How
can the physical arrangement of your computer(s) help you? How can you
design assignments to help? What Bible stories can you share and discuss
with your students to help teach them to be honest in their studies?

 About Plagiarism and Pixels

Font Size
Make the font size large so kids can see it easily or change the font size to
show on your monitor in your classroom. Ctrl and + will also work in most
browsers.

How to Change Font Size in Netscape
in Internet Explorer

Hook Your Computer to Your Classroom TV

 Scan Converter Buyers Guide Tips and suggestions.

 How to Set Up Computers in Your Classroom

 A low cost multimedia classroom with pictures too!
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  Week 3: Information Literacy & Writing Across the
Curriculum

Fair Use

What is Fair Use and how does it apply to my project?

 Visit Copyright Bay to learn about Fair Use and how it applies to print,
media, and technology.

 Specifically this week, reference Multimedia Wharf.

The Multimedia Fair Use Guidelines provide the following specific limits on
the amount of copyrighted material that may be used in student and faculty
multimedia projects.

 For motion media -(e.g., video clips) up to 10% or 3 minutes,
whichever is less.

 For text- up to 10% or 1000 words, whichever less.

 For poems -

up to 250 words.
Three poem limit per poet
Five poem limit by different poets from an anthology.

 For music - up to 10% or 30 seconds, whichever is less.

 For photos and images

Up to 5 works from one author.
Up to 10% or 15 works, whichever is less, from a collection.

 Database information-- up to 10% or 2,500 fields or cell
entries, whichever is less.

 For your easy reference, you may wish to print Copyright Guidelines from
the December 2003/January 2004 issue of the Journal of Adventist
Education.

Citing Resources

The following examples are for document
electronic resources using the MLA
format. If you need them for APA format,
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check this link. Remember, it is
important that students document and
give credit for all resources from the
Internet, including graphics, sounds, and video for multimedia projects.

Documenting Electronic Resources
Purdue University Writing Lab. Using MLA Format. 2004. March 15, 2004.
<http://owl.english.purdue.edu/handouts/research/r_mla.html>.

 A web page
Author(s). Name of Page. Date of Posting/Revision. Date of Access.
<electronic address>.

N.B. It is necessary to list your date of access because web postings are
often updated, and information available at one date may no longer be
available later. Be sure to include the complete address for the site. Also,
note the use of angled brackets around the electronic address; MLA requires
them for clarity.

 An article in an online journal or magazine
Author(s). "Title of Article." Title of Journal Volume. Issue (Year):
Pages/Paragraphs. Date of Access <electronic address>.

N.B. Some electronic journals and magazines provide paragraph or page
numbers; include them if available. This format is also appropriate to online
magazines; as with a print version, you should provide a complete publication
date rather than volume and issue number.

 Email
Author. "Title of the message (if any)" E-mail to person's name. Date of the
message.

 A listserv posting
Author. "Title of Posting." Online posting. Date when material was posted (for
example: 18 Mar. 1998). Name of listserv. Date of access <electronic
address for retrieval>.

 An image
Artist if available. "Description or title of image." Date of image. Online image.
Title of larger site. Date of download. <electronic address>.
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